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Carrier Electronic Catalog Customer Suite v20120203 replaces v20111216

SOFTWARE DESCRIPTION

The Carrier Electronic Catalog Suite automatically installs all Carrier Electronic Catalog (E-CAT) programs using a
single installation file. This is an alternative to downloading and installing individual E-CAT programs one by one.

The February 3, 2012 Electronic Catalog Suite release automatically installs the following programs:

 X-Builder Framework v1.04u  Fan Coil Builder v4.00
AHUBuilder v6.20 Packaged RTU Builder v1.29o
Air Terminal Builder v2.02 Self-Contained Units Builder v2.09r

 Applied RTU Builder v3.09h Unit Ventilator Builder v1.19b
 Commercial Split Systems Builder v1.23 Water Source Heat Pump Builder v4.29d

Programs marked with the symbol  have been updated since the December 16, 2011 release.

INSTALLATION PROCEDURES

Installation via Internet Download
 Download the ecat-cec20120203.exe file from the Internet site and save it in a folder on your hard disk. Note

that the download file is large and a fast internet connection is necessary to efficiently download this file.
 Run Windows Explorer and double-click on the ecat-cec20120203.exe file. This launches the program installer.
 Follow the installation instructions that appear on your screen.
 Note AutoDesk Volo View Express® must also be installed for certain E-CAT programs to function correctly.

AutoDesk Volo View Express® can be downloaded from the internet site.

Installation via E-CAT CD
 Insert the E-CAT CD-ROM in your CD drive.
 On most computers, the software installation will start automatically. If it does not, double click the setup.exe

file in the root folder of the CD to launch installation.
 Follow the installation instructions that appear on your screen.
 Note AutoDesk Volo View Express® must also be installed for certain E-CAT programs to function correctly.

The AutoDesk Volo View Express® installer can be found in the \VoloView folder on the CD.

Running the Program
Use the following procedure to run the program:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II programs.
 In the Carrier E-CAT/E20-II Programs group click Carrier Electronic Catalog v1.04u. From Electronic Catalog

you can run all other E-CAT programs.

Minimum Computer Requirements:
 Hard Disk Space: Up to 556 megabytes when installing software for the first time. The hard disk space

requirement is much smaller when updating existing versions of the software.
 Random Access Memory: At least 128 megabytes (256 megabytes recommended).
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 Autodesk Volo View Express®



February, 2012 Page 2 of 2

Carrier Software Systems
Syracuse, NY, USA

1-800-253-1794
software.systems@carrier.utc.com

Carrier Electronic Catalog
Customer Suite

Version 20120203
Release Sheet

INSTALLATION PROCEDURES (continued)

Note: Certain E-CAT programs require you to install the current version of Autodesk Volo View Express®
programs. This program can be downloaded from the E-CAT download table on the internet site. Volo View
Express® (copyright Autodesk, Inc.) is freely distributed by Autodesk, Inc. as its drawing viewer. Any redistribution
of Volo View Express® must be in compliance with the Software License Agreement that is displayed during the
Volo View Express® installation.

PREVIOUS VERSION INFORMATION

If your computer contains the prior versions of the Carrier E-CAT programs, the E-CAT Suite will automatically
replace the prior version when installed. As a result it is not necessary for you to uninstall the prior version before
installing the E-CAT Suite. Exceptions only exist for a major version change or a new program and in that case the
prior version can be uninstalled before or after installing the E-CAT Suite.

In the February 3 Customer Suite Fan Coil Builder v4.00 is a major version update. All other releases are minor
version updates.

NOTES

1. Release Sheets. Release sheets for individual Electronic Catalog programs are found in the "E-CAT Product
Selection Programs" down load table on the internet site. These sheets describe new program features.

2. Adobe Acrobat. Adobe Acrobat Reader v4.05 or later is required to view certified drawings in certain E-CAT
programs. If Acrobat Reader is not yet installed on your computer, the latest version can be downloaded from
www.adobe.com/products/acrobat and then installed.

http://www.adobe.com/products/acrobat


X Builder Framework

v1.04u



February 2012 Page 1 of 1

Carrier Software Systems
Syracuse, NY, USA

1-800-253-1794
software.systems@carrier.utc.com

Carrier Electronic Catalog
X Builder Framework v1.04u

Release Sheet

X Builder Framework v1.04u replaces v1.04t

PROGRAM DESCRIPTION

X Builder Framework provides common features for most Electronic Catalog and E20 II programs. It can also be
used as a central launch portal for all Electronic Catalog software. The software appears as "Carrier Electronic
Catalog" on the Start/Programs Menu.

If you launch the X Builder Framework from the “Carrier Electronic Catalog” icon on the Start Menu you can make
best use of these common features. For example, you can configure any Tag in an existing ECAT Project simply by
double-clicking the Tag on the Project tree, or create any kind of new Tag in the Project by clicking the New Tag
button.

X Builder Framework v1.04u corrects the following problem:
 In certain situations a tag created using the "Copy Tag" feature displayed the name of the original tag instead of

the new tag.

Please refer to the X Builder Support Notes in the Software/Program Downloads section of the web site, or from
Carrier Electronic Catalog’s “Welcome” screen for more information.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-xbf104u.exe file from the internet site and save it in a folder on your hard disk.
 Close any other programs running on your desktop computer.
 Run Windows Explorer and double-click on the ecat-xbf104u.exe file. This launches the program installer.
 Follow the installation instructions, which appear on your screen. After installation you may be asked to reboot.

Running the Program

Use the following procedure to run the program in “Carrier” mode:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II programs.
 In the Carrier E-CAT/E20-II Programs group click on the Carrier Electronic Catalog v1.04u icon.

Minimum Computer Requirements:
 Hard Disk Space: 30 megabytes.
 Random Access Memory: 128 megabytes minimum, 256 megabytes recommended.
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.

SPECIAL NOTES

1. Adobe Acrobat, AutoDesk VoloView. Certain X Builder Framework components depend on Adobe Acrobat
Reader and Autodesk Voloview drawing viewer. These components are included in the CD installs, but may
need to be downloaded and installed separately if you are installing from the internet and your computer does not
yet contain this software.
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AHU Builder v6.20 replaces v6.19a.

UPDATE DESCRIPTION

AHUBuilder v6.20 includes the following changes:
 Added "Factory Mounted VFD in VFD Plenum with External Bypass" for 39MW outdoor models.
 Added Baserail Splits for 39L models.
 Added more Viewport options for 39M models.
 Improved the 39M “Coil Connection Drawing” by adding a table of dimensional and descriptive information for

each connection point.
 Added coil drawings to the 39L Submittal Report.
 Improved coil selection with brines by adding more coil geometry choices.

In addition the following problem was corrected:
 For 39L pre-heat water coil drawings, left hand units, the Supply and Return were mislabeled.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-sd3620.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-sd3620.exe file. This launches the program installer.
 Follow the installation instructions that appear on your screen.
 Note that X Builder Framework and AutoDesk Volo View Express® must also be installed for AHUBuilder to

function correctly. Both can be downloaded from the internet site.

Running the Program:
Carrier Electronic Catalog can be used to launch AHUBuilder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via the
Programs tab.

AHUBuilder can also be launched from the Start Menu:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 Then choose Individual Product Builders.
 Finally click on the AHUBuilder v6.19b item.

Minimum Computer Requirements:
 Hard Disk Space: 30 megabytes (for program and submittal drawing managers)
 Random Access Memory: At least 32 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 E-CAT/E20-II Configuration Services v2.1
 Autodesk Volo View Express®

Note: X-Builder Framework and Autodesk Volo View Express® programs should be installed prior to installing and
running AHU Builder. Both can be downloaded from the internet site. Volo View Express® (copyright Autodesk,
Inc.) is freely distributed by Autodesk, Inc., as its drawing viewer. Any redistribution of Volo View Express® must
be in compliance with the Software License Agreement which is displayed during the Volo View Express®
installation.
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PREVIOUS VERSION INFORMATION

1. Converting Tags From Existing Projects. Project data from AHUBuilder 6.10 through 6.19a can be converted
for use in v6.20 as follows:
 Start AHUBuilder v6.20 directly, either via Start > Programs > Carrier E-CAT and E20-II Programs >

Individual Product Builders, or via the Programs tab in Electronic Catalog.
 Open the desired project containing AHUBuilder tags. Initially no tags will be visible in AHUBuilder.
 Choose the "Convert from Prior Version" option on the File Menu. Tags will be converted and will then

appear in AHUBuilder. A summary report of required changes and/or errors will be displayed. These tags
will also appear in the Electronic Catalog project tree once saved.

 Note that this procedure must be repeated for each existing project you wish to use in AHUBuilder v6.20.

2. Converting Project Archives. Project Archives from AHUBuilder 6.10 through 6.19a must be retrieved using
AHUBuilder 6.1x or Carrier Electronic Catalog before they can be converted to AHUBuilder version 6.20.

3. Uninstalling AHUBuilder v6.19a. AHUBuilder v6.20 will not replace v6.19a automatically. AHUBuilder v6.19a
must be uninstalled separately by using the following procedure:
 Do not uninstall v6.19a until you finish converting v6.19a data to v6.20 format (see item #1 above).
 Then, start the Carrier Electronic Catalog.
 Click on the Programs tab and highlight the AHUBuilder 6.1 item on the tree.
 Click the “Remove Program” button to uninstall AHUBuilder 6.19a.

SPECIAL NOTES

1. XBuilder The latest version of X Builder Framework should be installed before installing AHU Builder.

2. AutoDesk VoloView Express® must be installed in order to view DXF Certified and Template drawings in the
program.
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Air Terminal Builder v2.02 replaces v2.01

UPDATE DESCRIPTION

Air Terminal Builder v2.02 includes the following changes:
 Added a unit casing right hand option for 45J/45Q and 45R units.
 Added "LineaCross" sensor type for 35E/J/L/N units and all 45-series fan powered box units.
 Added wiring diagrams to the certified drawings offered for 35E/35J units and all 45-series fan powered box

units.
 Added "(DOAS available)" to the description shown in the selection wizard for 45Q series fan powered boxes.
 Added "What's This" feature to the Design Criteria tab of the configurator. To use the feature click "What's

This", move the cursor to an input item and click the right mouse button. A pop-up message will appear
displaying information about the input.

 Removed "Linear Averaging" sensor type 35E/J/L/N units and all 45-series fan powered box units as this type is
now obsolete.

In addition, the following problems were corrected:
 For 45Q size 3 units using the DOAS coil option, the radiated sound values were incorrect for Octave Band 2.
 For 45R parallel fan powered boxes with electric or hot water reheat, the certified drawings were incorrect.
 When a 45Q series fan powered box included the DOAS coil option, the diagram shown on the Design Criteria

tab incorrectly omitted the sensible cooling coil. Please note that all calculations of terminal operating
conditions on this tab were correct. Only the diagram was incorrect.

Note: X Builder Framework v1.04t must be installed before installing Air Terminal Builder v2.02.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-atb202.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-atb202.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note: The current X Builder Framework should be installed prior to installing the Air Terminal Builder. It can

be downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Air Terminal Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via
the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: Up to 37 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 The current XBuilder Framework should be installed prior to installing the Air Terminal Builder.
 Autodesk Volo View Express®
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INSTALLATION PROCEDURES (continued)

Please note that Air Terminal Builder requires that you download and install the current X Builder Framework and
the AutoDesk VoloView Express® programs. Both of these can be downloaded from the E-CAT download table on
the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed by AutoDesk Inc., as its
drawing viewer. Any redistribution of VoloView Express® must be in compliance with the Software License
Agreement which is displayed during the VoloView Express® installation.

PREVIOUS VERSION INFORMATION

1. Air Terminal Builder v2.02 will replace v2.01 automatically. It is not necessary to uninstall v2.01 before
installing v2.02.

2. Existing projects created with Air Terminal Builder v2.01 can be used immediately in v2.02, but they will
initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name
in the projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the
right hand pane.

3. Tags in existing projects created with any v1.09 version Air Terminal Builder can be used in v2.02, however tags
in these projects must be converted before they can be used with v2.02. To convert the tags, use the following
steps:
 Start Air Terminal Builder v2.02.
 Choose the "Convert Project" item on the File Menu.
 A window will appear listing all current projects that contain v1.09 tags. Select all projects whose tags you

wish to convert. Then press OK.
 Tags in the selected projects will be converted.
 When you are returned to the program main window, the tags are ready for use with v2.02.

This conversion process has been tested with versions 1.09f through 1.09h. Conversion of prior version tags is
not guaranteed, but the more recent the tag, the better its chance of successful conversion. If you encounter
problems with an earlier tag, you can first run Air Terminal Builder v1.09h, select a project in the project tree on
the left and then click the "Update All Tags" button at the bottom of the right hand panel. Then convert the tags
to v2.02 using the bullets above.

SPECIAL NOTES

1. X-Builder Framework. The current version of XBuilder Framework should be installed before installing Air
Terminal Builder.

2. Chilled Beams can now be configured and ordered through the Air Terminal Builder. Performance calculations
are not yet available in the Builder. Please contact Air Terminal Marketing for performance calculation data.

3. Adobe Acrobat. Adobe Acrobat Reader v4.05 or later is required to view certified drawings. If this software
has not yet been installed on your computer, download the latest version of Adobe Acrobat Reader from
www.adobe.com/products/acrobat and install it.

4. VoloView. VoloView v2020-129 or later is required to view CAD templates from within Commercial Split
Systems Builder. If this software has not yet been installed on your computer, you can do so by running
Windows Explorer, navigating to the \VOLO_NEW folder on the E-CAT CD and then double-clicking on the
VVE2SETUP.EXE file. Note that if you do not intend to view templates within Commercial Split Systems
Builder, this software is not needed. Many users display template drawings using a CAD system such as
AutoCAD instead.

http://www.adobe.com/products/acrobat
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Applied RTU Builder v3.09h replaces v3.09g

PROGRAM DESCRIPTION

Applied RTU Builder v3.09h includes the following changes:
 Added Low Compressor Sound Accessory for “A” series models.
 Added 65kA SCCR, Low Compressor Sound Accessory and LP Accessory restrictions for “P” series models.
 Updated the 62D filter accessories usage table.
 Applied frost control limitations on 62E.
 For 62D selections, when “None” is selected for the DX Reheat coil, a message appears (“Are you sure HGRH is

not required? See Bulletin 111-11-43”) and the user asked to confirm the choice.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-rtu309h.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-rtu309h.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note: AutoDesk VoloView Express® and the latest X Builder Framework should be installed prior to installing

the Packaged RTU Builder. Both can be downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Applied RTU Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing rooftop tags via the Project tab, or you can directly launch the
program via the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: 40 megabytes
 Random Access Memory: At least 256 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 The latest X Builder Framework should be installed prior to installing the Packaged RTU Builder.
 AutoDesk VoloView Express®

AutoDesk VoloView Express® and the latest X Builder Framework should be installed before running this program.
Both can be downloaded from the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed
by AutoDesk Inc., as its drawing viewer. Any redistribution of VoloView Express® must be in compliance with the
Software License Agreement which is displayed during the VoloView Express® installation.

PREVIOUS VERSION INFORMATION

1. Applied RTU Builder v3.09h will replace v3.09g automatically. It is not necessary to uninstall v3.09g before
installing v3.09h.

2. Existing projects created with Applied RTU Builder v3.09g can be used immediately in v3.09h, but they will
initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name
in the projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the
right hand pane.
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SPECIAL NOTES

1. XBuilder The latest version of X Builder Framework should be installed before installing Applied RTU Builder.

2. AutoDesk VoloView Express® must be installed in order to view DXF template drawings in the program.
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Commercial Split Systems Builder v1.23 replaces v1.22

UPDATE DESCRIPTION

Commercial Split Systems Builder v1.23 includes the following changes:
 Changed quantity two for liquid line solenoid valve and sight glass accessories selected for two-circuit units.
 Added CO2 sensor accessories for 40RU indoor units.
 Made scrolling marquee display standard on all 38AP outdoor condensing units. This was previously an optional

feature.

In addition the following problem was corrected:
 For 38AP outdoor condensing unit models sizes 115 and 130 in which the dual point connection option was

selected, the Performance Summary report displayed incorrect electrical MCA or MOCP data. MCA and MOCP
data is not available for these units. Therefore no data should be shown.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-csb123.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-csb123.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note: AutoDesk VoloView Express® and the latest X Builder Framework should be installed prior to installing

the Commercial Split Systems Builder. Both can be downloaded from the internet site.

Running the Program

Carrier Electronic Catalog can be used to launch Commercial Split Systems Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via
the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: Up to 50 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 The latest XBuilder Framework should be installed prior to installing the Commercial Split Systems Builder.
 Autodesk Volo View Express®

Please note that Commercial Split Systems Builder requires that you download and install X Builder Framework and
the AutoDesk VoloView Express® v2000-129 programs. Both of these can be downloaded from the E-CAT
download table on the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed by
AutoDesk Inc., as its drawing viewer. Any redistribution of VoloView Express® must be in compliance with the
Software License Agreement which is displayed during the VoloView Express® installation.
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PREVIOUS VERSION INFORMATION

1. Commercial Split Systems Builder v1.23 will replace v1.22 automatically. It is not necessary to uninstall v1.22
before installing v1.23.

2. Existing projects created with Commercial Split Systems Builder v1.22 can be used immediately in v1.23, but
they will initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the
project name in the projects tree on the left and then click the “Update All Tags” button which appears at the
bottom of the right hand pane.

SPECIAL NOTES

1. XBuilder. The latest version of XBuilder Framework should be installed before installing Commercial Split
Systems Builder.

2. Adobe Acrobat. Adobe Acrobat Reader v4.05 or later is required to view certified drawings. If Acrobat Reader
is not yet installed on your computer, the latest version can be downloaded from
www.adobe.com/products/acrobat and then installed.

3. AutoDesk VoloView Express® must be installed in order to view DXF template drawings in the program.

http://www.adobe.com/products/acrobat
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Fan Coil Builder v4.00 replaces v3.39g

UPDATE DESCRIPTION

Fan Coil Builder v4.00 adds an Excel-like input screen for entering, viewing and revising fan coil tags. This feature
makes it much easier to select and configure fan coil equipment by allowing the user to:
 Simultaneously view all tags of similar product types in a spreadsheet format.
 Review tag data to quickly verify equipment data is correct.
 Copy product features or design conditions from one tag and paste into other tags.
 Quickly identify invalid tags and other problems.
 Efficiently change factory options and design parameters for multiple tags at one time.
 Duplicate existing tags by copying and pasting.
 Quickly calculate all tags in the spreadsheet with one button click.

In addition the following problems were corrected in v4.00:
 Acoustic data for all fan coil units was incorrect. It had not been updated for the latest changes in the product

catalogs.
 For certain fan coil units, the unit dimensions displayed on the Unit Report were incorrect.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-fcb400.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-fcb400.exe file. This launches the program installer.
 Follow the installation instructions that appear on your screen.
 Note: The current version of X Builder Framework and AutoDesk VoloView Express® should be installed prior

to installing the Fan Coil Builder. Both can be downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Fan Coil Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing fan coil tags via the Project tab, or you can directly launch the
program via the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: 20 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 The current version of XBuilder Framework should be installed prior to installing the Fan Coil Builder.

Please note that Fan Coil Builder requires that you download and install the current X Builder Framework
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PREVIOUS VERSION INFORMATION

1. Converting Tags From Existing Projects. Tags in existing projects created with prior versions of Fan Coil
Builder v3.39g can be used in v4.00, however tags in these projects must be converted before they can be used
with v4.00. To convert the tags, use the following steps:
 Start Fan Coil Builder v4.00.
 Choose the "Convert Project" item on the File Menu.
 A window will appear listing all current projects that contain v3.30 through 3.39g tags. Select all projects

whose tags you wish to convert. Then press OK.
 Tags in the selected projects will be converted.
 When you are returned to the program main window, the tags are ready for use with v4.00.

This conversion process has been tested with version 3.39g. Conversion of prior version tags is not guaranteed,
but the more recent the tag, the better its chance of successful conversion. If you encounter problems with an
earlier tag, you can first run Fan Coil Builder v3.39g, select a project in the project tree on the left and then click
the "Update All Tags" button at the bottom of the right hand panel this converts the data to v3.39g compatibility.
Then convert the tags to v4.00 using the bullets above.

2. Uninstalling Fan Coil Builder v3.39g. Fan Coil Builder v4.00 will not replace v3.39g automatically. Version
3.39g must be uninstalled separately using the following procedure:
 Start Electronic Catalog.
 In the main window click the Programs tab.
 Highlight Fan Coil Builder v3.3 in the tree on the left.
 Then click the "Remove Program" button in the right-hand panel.

SPECIAL NOTES

1. XBuilder. The latest version of XBuilder Framework should be installed before installing Fan Coil Builder.
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Packaged RTU Builder v1.29o replaces v1.29m.

UPDATE DESCRIPTION

Packaged RTU Builder v1.29o includes the following changes:
 Added EnergyX factory installed option to 48/50HC (15 to 25 ton) units.
 Modified the description for sensor –HH—57AC-078. Revised the program so this sensor is not offered for a unit

with factory installed enthalpy economizer.
 Revised the program so the low ambient control accessory is not offered for a unit with HumidiMiZer.
 Revised the coil option names on the factory options tab to indicate evaporator and condenser more clearly. For

example the "CuCu-AlCu" option becomes "CuCu Cond - AlCu Evap".
 Added a note to recommend using a disconnect switch bracket for applications requiring a unit mounted

disconnect of greater than 100 amps.
 Modified the Performance Summary to report moisture removed in gal/hr for units with HumidiMiZer.

In addition v1.29n corrects the following problems:
 Electrical data for 50TC sizes 17-28 was incorrect.
 Names of certain items appearing in the Coil Option drop-down list on the factory options tab were truncated.

For example "CuCu-AlCu" might have been incorrectly listed as "CuCu".
 When low ambient control was added to a 50HCQ size 09 unit, the required relay was not automatically added.
 When low ambient control was added to a 50HCQ unit, a capacitor was incorrectly added to the unit.
 For 48/50TC (7.5 – 12.5 ton) 2-stage compressor units, performance ratings were incorrectly based on single stage

compressor units.
 On the Acoustic Report the values listed for "distance of unit from the ground" and "height of the receiver" were

incorrect. Note that is a cosmetic error. The acoustic calculations and performance results were correct. Only the
listing of these two input values was incorrect.

 The full load cooling ratings for the 48/50HC size 28 with HumidiMiZer was incorrect.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-prb129o.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-prb129o.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note: AutoDesk VoloView Express® and the latest X Builder Framework should be installed prior to installing

the Packaged RTU Builder. Both can be downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Packaged RTU Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing tags via the Project tab, or you can directly launch the program via
the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: 40 megabytes
 Random Access Memory: At least 256 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 The latest X Builder Framework should be installed prior to installing the Packaged RTU Builder.
 AutoDesk VoloView Express®
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INSTALLATION PROCEDURES

AutoDesk VoloView Express® and the latest X Builder Framework should be installed before running this program.
Both can be downloaded from the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed
by AutoDesk Inc., as its drawing viewer. Any redistribution of VoloView Express® must be in compliance with the
Software License Agreement which is displayed during the VoloView Express® installation.

PREVIOUS VERSION INFORMATION

1. Packaged RTU Builder v1.29o will replace v1.29n automatically. It is not necessary to uninstall v1.29n before
installing v1.29o.

2. Existing projects created with Packaged RTU Builder v1.29n can be used immediately in v1.29o, but they will
initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name
in the projects tree on the left and then click the “Update All Tags” button at the bottom of the right hand pane.

SPECIAL NOTES

1. XBuilder The latest version of X Builder Framework should be installed before installing Packaged RTU
Builder.

2. AutoDesk VoloView Express® must be installed in order to view DXF template drawings in the program.
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SCU Builder v2.09r replaces v2.09q

PROGRAM DESCRIPTION

SCU Builder v2.09r includes the following changes:
 Added a mixed air calculator feature to the Design Criteria tab.
 Added the Certified Drawing for 50XCA units.

In addition the following problem was corrected.
 Economizer water pressure drop has been corrected for 50BVC and 50BVJ size 034 units.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full install, please use the following procedure:
 Download the ecat-scu209r.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-scu209r.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note that X Builder Framework should be installed prior to installing SCU Builder. It can be downloaded from

the internet site.

Running the Program
Use the following procedure to run the program:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II programs.
 In the Carrier E-CAT/E20-II Programs group choose Individual Product Builders.
 In the Individual Product Builders group click on the SCU Builder v2.09r item.

Minimum Computer Requirements:
 Hard Disk Space: Up to 50 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later).
 The current X Builder Framework should be should be installed prior to installing the SCU Builder.
 Autodesk Volo View Express®

PREVIOUS VERSION INFORMATION

1. SCU Builder v2.09r will replace v2.09q automatically. It is not necessary to uninstall v2.09q before installing
v2.09r.

2. Data created with v2.09q is immediately usable in SCU Builder v2.09r. There is no data conversion required.
However, to make all your tags valid in v2.09r, highlight the Project name in the Projects tree and then click on
the button “Update and Recalculate all Tags”.

SPECIAL NOTES

1. X Builder. The latest version of XBuilder Framework should be installed before installing SCU Builder.
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Unit Ventilator Builder v1.19b replaces v1.19a.

UPDATE DESCRIPTION

Unit Ventilator Builder v1.19b resolves the following issue:
 For 4-pipe DX systems using the factory option "Open controller with Face & Bypass controls", "None" was

incorrectly offered as an option for the cooling valve/actuator.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full install, please use the following procedure:
 Download the ecat-uvb119a.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-uvb119a.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note: AutoDesk VoloView Express® and the current version of X Builder Framework should be installed prior

to installing the Unit Ventilator Builder. Both can be downloaded from the internet site.

Running the Program
Carrier Electronic Catalog can be used to launch Unit Ventilator Builder. To start Electronic Catalog:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT and E20-II programs.
 In the Carrier E-CAT and E20-II Programs group choose the Carrier Electronic Catalog item. From Electronic

Catalog you can create new or edit existing fan coil tags via the Project tab, or you can directly launch the
program via the Programs tab.

Minimum Computer Requirements:
 Hard Disk Space: Up to 37 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows 98, 2000, XP, Vista or Windows NT (with service pack 4 or later).
 The current X Builder Framework should be installed prior to installing Unit Ventilator Builder.
 Autodesk Volo View Express®

Please note that Unit Ventilator Builder requires that you download and install the current X Builder Framework and
the AutoDesk VoloView Express® programs. Both of these can be downloaded from the E-CAT download table on
the internet site. VoloView Express® (copyright Autodesk, Inc.) is freely distributed by AutoDesk Inc., as its
drawing viewer. Any redistribution of VoloView Express® must be in compliance with the Software License
Agreement which is displayed during the VoloView Express® installation.

PREVIOUS VERSION INFORMATION

1. Unit Ventilator Builder v1.19b will replace v1.19a automatically. It is not necessary to uninstall v1.19abefore
installing v1.19b.

2. Existing projects created with Unit Ventilator Builder v1.19a can be used immediately in v1.19b, but they will
initially contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name
in the projects tree on the left and then click the “Update All Tags” button which appears at the bottom of the
right hand pane.
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SPECIAL NOTES

1. X-Builder Framework. The current version of XBuilder Framework should be installed before installing Unit
Ventilator Builder.

2. Adobe Acrobat. Adobe Acrobat Reader v4.05 or later is required to view certified drawings. If this software
has not yet been installed on your computer, download the latest version of Adobe Acrobat Reader from
www.adobe.com/products/acrobat and install it.

3. VoloView. VoloView v2000-129 or later is required to view template drawings from within Commercial Split
Systems Builder. If this software has not yet been installed on your computer, you can do so by running
Windows Explorer, navigating to the \VOLO_NEW folder on the E-CAT CD and then double-clicking on the
VVE2SETUP.EXE file. Note that if you do not intend to view templates within Commercial Split Systems
Builder, this software is not needed. Many users display template drawings using a CAD system such as
AutoCAD instead.

http://www.adobe.com/products/acrobat
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WSHP Builder v4.29d replaces v4.29c

UPDATE DESCRIPTION

WSHP Builder 4.29d includes the following changes:
 Added the WSHP Open Controls factor option for 50Hz product lines.
 Revised the unit size restrictions for airflow configurations for 50PC units.
 Revised the part number digits for the control options for 50PS export models.
 Updated the list of part numbers available for QuickShip.

INSTALLATION PROCEDURES

Installation via Internet Download
To perform a full program install, please use the following procedure:
 Download the ecat-wsh429d.exe file from the Internet site and save it in a folder on your hard disk.
 Run Windows Explorer and double-click on the ecat-wsh429d.exe file. This launches the program installer.
 Follow the installation instructions which appear on your screen.
 Note: The latest X Builder Framework should be installed prior to installing WSHP Builder. X Builder is

available for download from the Internet site.

Running the Program

Use the following procedure to run the program:
 From the Windows desktop press Start, choose Programs and then choose Carrier E-CAT/E20-II Programs.
 In the Carrier E-CAT/E20-II Programs group click on the Individual Product Builders icon.
 In the Individual Product Builders group click on the WSHP Builder v4.29d icon.

Minimum Computer Requirements:
 Hard Disk Space: 20 megabytes
 Random Access Memory: At least 64 megabytes
 Display Monitor: At least VGA with 600x800 resolution and 256 colors.
 Operating System: Windows XP, Windows Vista or Windows 7.
 The current X Builder Framework should be installed prior to installing WSHP Builder.

PREVIOUS VERSION INFORMATION

1. WSHP Builder v4.29d will replace v4.29c automatically. It is not necessary to uninstall v4.29c before installing
v4.29d.

2. Existing projects created with WSHP Builder v4.29c can be used immediately in v4.29d, but they will initially
contain only invalid tags. To quickly make all tags valid in the new version, highlight the project name in the
projects tree on the left and then click the “Update All Tags” button at the bottom of the right hand pane.

SPECIAL NOTES

1. X Builder. The current X Builder Framework should be installed prior to installing WSHP Builder.


